CHAPTER 3

Map outputs for GIS projects

LEARNING GOALS

• Learn about alternatives for sharing maps and information from GIS projects.
• Build map layouts.
• Add visibility ranges for interactive map use.
• Build ArcGIS StoryMaps stories.
• Make professional-quality tables and charts in Microsoft® Excel (optional).

Introduction

Map outputs start with the interactive maps you have been creating and using in ArcGIS Pro in chapters 1 and 2. Those maps are fine and may be all you need personally, but what about others who need spatial information—your friends, your boss or clients, a group to which you belong, stakeholders in a public policy issue, or the public at large? What if they do not have ArcGIS Pro, and if they do, what if they don’t have your GIS files? This chapter focuses on providing maps that others can access, even users who may have no GIS knowledge or software. In addition to accessibility, this chapter also introduces GIS outputs, including map outputs that have nonmap elements to enable map reading and interpretation.

Consider the problem, addressed in this chapter, of college students about to get their undergraduate degrees from fine arts programs. They love their field of art, but it’s difficult to find good-paying jobs in fine arts, or in some cases, any jobs at all. They’re willing to relocate if they can find their dream jobs.

Suppose that a national organization for promoting fine arts education wants you to complete a GIS project—namely, to build a tool for arts students that allows them to explore employment possibilities. The tool is an interactive map that displays the number of employees and average incomes in the arts field by state and city in the United States. The tool also addresses the complex but essential issue of cost of living. For example, is a $60,000-a-year job in New York City better financially than a $30,000-a-year job in Columbus, Ohio, after cost of living is factored in? It’s not, if the cost of living
in New York City is more than twice that of Columbus, assuming that all income is spent on living expenses.

Suppose further, that you’ve already collected the data and have maps built in ArcGIS Pro. How can you get the results into the hands of arts students across the United States and around the world? In the days before ArcGIS Online and apps such as ArcGIS StoryMaps (that you’ll learn to use in this chapter), there was no easy answer to this question. Now, there are good answers, with a range of old and new options available depending on your map audience’s needs.

In general, to share maps from a GIS project, the map outputs must be accessible and readable, and they must also tell a story, to wit:

1. **Be accessible:** Make your maps available in hard-copy documents, via email or links, from a website or an app. Each form of output is valuable for different circumstances. A lay audience may be best served with static maps (images), printed in a document or on a presentation slide. That form of output does not require an audience to learn how to navigate an interactive map, and the author controls the desired message, with maps designed to share information. More sophisticated users may want to explore spatial information on their own, focusing on items and areas of interest to them (and unpredictable by you in advance) in an interactive app.

2. **Be readable:** Include titles, legends, scales, and other elements that allow direct interpretation of maps. These elements, called map surrounds, are essential.

3. **Tell a story:** Explain as needed the context, sources, and quality of data, problem addressed, map solution, analysis, and limitations of the solution. GIS projects include stories that have one or more maps at the center, but the projects also may need text, data tables, charts, images, and hyperlinks.

One solution is to publish maps in ArcGIS Online and make them publicly available in an app such as ArcGIS Explorer. Then anyone can search for and interactively use your maps, or you can send anyone the URLs of the maps. That solution takes care of most accessibility and readability issues, and you already know how to publish maps online.

Another option is to create map layouts that include one or more maps and surrounds for interpretation. Then you can export a layout as an image file (for example, JPEG) and paste the file in a Microsoft Word document report or a PowerPoint slide in a presentation. You also can embed a layout in a web page to cover all three issues noted earlier, albeit with static maps. You’ll learn how to create a layout in this chapter.

A third option is to use one or more maps you published in ArcGIS Online in a StoryMaps story. StoryMaps includes many apps that not only have one or more interactive maps but also allow you to include map surrounds, text, images, hyperlinks, and other materials. StoryMaps stories require little or no knowledge of website hosting, publishing, or underlying web programing.

This chapter includes two additional, supporting topics for you to use in GIS outputs. The first topic is visibility ranges, which enhance interactive map output for complex or detailed maps. The basic idea of visibility ranges is simple. When zoomed far out or at full extent (at small scales), you can automatically have major map layers turned on but detailed layers turned off. Then when you zoom in (to large scales), you can have detailed layers turned on when you need to see them. The second topic focuses on creating tables and charts in Microsoft Excel for use in StoryMaps stories. Tutorial 3-4 is optional for those who do not have Microsoft Excel skills and want to make
professional tables and charts, and save them as screen captures to be used as resources in building StoryMaps story content.

**Tutorial 3-1: Layouts**

In this tutorial, you will build a map layout with two maps. Once you learn this skill, you can build any kind of layout, with one, two, or several maps, plus other elements. The purpose of the layout you will build next is to provide state-level information on the location of jobs in the arts field and average annual wages.

The layout you’ll build doesn’t have a layout title (at the top such as “Maps showing arts employment, 2015”). The reason is because this layout, like most you’ll produce, is destined to be used as a figure in a report, a slide in a presentation, or an image on a website. The layout title is better created in a word processor as a figure caption, in a presentation package as a slide title, or on a website.

**Arts employment per 1,000 population and annual average wages**

![Map of arts employment and average wages](image1)

**Arts employment per 1,000 population and annual average wages**

![Map of arts employment and average wages](image2)
Open the Tutorial 3-1 project

Both maps for which you will need to build a layout already exist and are ready for use in the Tutorial 3-1 project file that you are about to open.

1. **Open Tutorial3-1.aprx from Chapter3\Tutorials, save it as Tutorial3-1YourName.aprx, and zoom to full extent.**

2. **Open the second map, Arts Employment, and zoom to full extent.**
Chapter 3: Map outputs for GIS projects

Create a layout

A layout starts as a blank canvas to which you can add one or more maps, surrounds, and other elements of your choice and design. Although it’s possible to add images of tables and charts to layouts, tables and charts are better placed in reports, presentations, and websites as separate tables and figures. Therefore, you can keep your layouts simple and just include maps, legends, and other common map surround elements.

1. On the Insert tab, click the New Layout button \( \text{New} \) > Letter 8.5” × 11”. You can widen your ArcGIS Pro window if you don’t see the New Layout button.

2. In the Catalog pane, rename the layout as Arts Employment Layout.

Add maps to the layout

1. In the Contents pane, right-click Arts Employment Layout, and click Zoom To Page.

2. On the Insert tab, click the Map Frame arrow, select the Arts Employment per 1,000 Population map on the right of Default, click and drag a bounding box in the top half of the layout, and release the mouse. This adds the selected map displays to the layout.

3. Likewise, insert the Arts Employment map from the second row, but in the bottom half of the layout.

Resize and place the two maps

Next, you must resize the two maps in the same dimensions and set their positions. Setting the dimensions is not an exact determination, except that the maps should be the largest elements in the layout. Planning and trial and error are involved in getting a layout to look right. This exercise provides a set of dimensions and placement locations to save you time and ensure your results match those of the finished layout shown at the beginning of this tutorial. In a later exercise to add legends to the layout, you’ll use an alternative, graphic method of sizing and locating layout elements.

1. Right-click the Arts Employment per 1,000 Population map (blue color scheme), and click Properties.

2. In the Format pane, click the Placement button \( \text{Properties} \), and type 5.5 for width and 3.5 for height, type 0.5 in. for X and 5.75 in. for Y.

3. With the Format pane still open, click the second map (Arts Employment, green color scheme), type its dimensions to be the same (5.5 by 3.5), and type 0.5 in. for X and 1.50 in. for Y. Close the Map Frame pane.
Next, you’ll change both maps in the layout to full extent.

4. **On the Layout tab in the Map group, for each map, click the Full Extent button, and click the Fixed Zoom-In button once so that the maps fill their frames.**

5. **Save your project.**

**Add guides**

In this exercise, you’ll use guides to position objects in a layout (legends, in this case). The guides are available from the horizontal and vertical rulers bordering the layout. When you drag objects, such as a map frame, they snap to guides. If there are intersecting vertical and horizontal guides, you can snap a corner of an object to the intersection.

1. **If your layout does not have horizontal and vertical rulers, right-click in the white area of the layout and select Rulers.**

2. **Right-click the vertical ruler at 5, and click Add Guide. Do the same at 9.25.** Hover in the ruler area, and click the arrow to adjust your guide placement if needed.
3. Right-click the horizontal ruler at 6.25, and click Add Guide, and then do the same for 8. You’ll place legends within the guides and bottoms of maps.

**Insert legends**

Using ArcGIS Pro, you’ll build a legend for all layers of a map that are turned on (all layers are turned on, in this case). The legend is dynamic: if you change symbolization on the map, turn on or off layers, and so on, the legend automatically updates in the layout.

1. Click the top map to make it active.

2. On the Insert tab, in the Map Surrounds group, click the Legend button, and drag a rectangle that snaps to the tall and narrow rectangle that your guides have formed on the right side of the map. ArcGIS Pro creates and draws the legend, but it does not draw completely, as indicated by the red dots in parentheses. The labeling for the choropleth map for the legend is too wide to fit in the layout. In the next exercise, you’ll fix this problem so that the entire legend is visible.
3. **Click the bottom map in the layout, and create its legend as shown.** This legend's labels are not too wide, so the legend draws completely within the available space.

---

**Modify legends**

Next, you will convert the top legend to a static graphic, ungroup legend elements, edit them to be narrower, and regroup them.

1. **Click the top legend, drag a selection handle on its right side to the right beyond the edge of the layout, and release the handle so that the entire legend draws.**

2. **Right-click the top legend, and click Zoom To Selected.**

3. **Right-click the top legend again, and click Convert To Graphics.** This action causes the legend to be static so that it no longer automatically updates if you turn layers on or off on maps or make other changes to the map.

4. **Right-click on the legend symbology, and click Ungroup.** Now the two parts of the legend are separate.

5. **Right-click and click Ungroup again.** Now each legend element is a separate graphic.

6. **In the top part of the legend, click States, and press Delete.**

7. **Click Employment per 1,000 Population, and press Delete.**
8. Double-click the Employment Arts/Population (Thousands) text box, and in the Format Text pane, click the Options button.

9. Under Text, in the Text box, place your pointer after Employment Arts, press Shift and Enter, and edit the text of the second line to read per 1,000 Population.

10. Adjust the text box for Employment Arts to display both lines of the legend heading.

11. Finally, select all elements of the legend by dragging a rectangle around them, right-click the selection, and click Group. Now the legend is back to being one graphic.